
 

Eye Choose You: Establishing Credibility w/ Online Review 
Websites 
Use the document outline (View > Show document outline) for easy navigation. 
 

Team Members 

Takahiro Shimokobe 
Tate Yeung 
Marianne Miranda 
Paula Zitnick 

Links 

project brief, class project sheet, project Drive folder 
 

 

Abstract 
Online review websites have been increasingly used by people in aiding their decision-making process over the 
years. Our study aims to find how users establish credibility of businesses, restaurants, or services through 
online review websites, namely Yelp. Founded in October 2004, Yelp is a local-search service powered by 
crowd-sourced reviews. We used eye-tracking to validate what information on a restaurant profile people attend 
to when determining credibility.  
 

 

Overview 
The purpose of our study is to analyze the behavior of participants when making decisions about businesses on 
Yelp, a local-search service powered by crowd-sourced reviews.  
 
We will do this through two means: a pilot survey and the use of the SMI RED250 to record visual scanning 
patterns and average dwell time spent on features. 
 
Our hypothesis is that ratings will have a significantly higher value to participants when making decisions to 
bookmark businesses. 
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Features, requirements, evaluation criteria 

Features  

● Determine what aspects of a review page are of interest or are relevant in affecting consumer choice 
and company sentiment,  

● What makes them effective (What consumers actually consider when making decisions) 

Requirements 

● Measure how people scan particular review pages visually 
● Compare what people say is “important” in a review versus what is observed through their actions  
● List top most effective features of a review that affect customer choice 
● Expect to have at least 5 participants, with 3 test cases 

Evaluation Criteria 

● Offer two examples of competing businesses (e.g. two taco restaurants) and then observe how users 
choose between the options (Example of test case) 

● Use eye tracking to detect visual patterns from users 
● Include pilot survey of user preferences for features 
● Users are able to choose between businesses concretely  
● Finding a significant difference between features in regards to where users establish credibility with 

businesses 
 

 

System design and architecture 

Our System 

Full scale Eye-tracking research study aimed towards evaluating where users establish credibility with 
businesses through Yelp.  
 

Components 

● Research participants (consisting of at least 7 volunteering participants) 
● SMI RED250 & Software 
● Chromebook 
● Researchers 
● SPSS 
● Pilot Study 
● Main Study 



 

Pilot Study 

This pilot study aims to find if there is a significant difference between importance of features when it comes to 
decision making for users of Yelp via an online survey. If there is a significant difference, we hope to find out 
which features are the most important.  
 

Objective 
 
Our goal is to study the behavior of participants when making decisions about businesses through Yelp.  

Main Study 

The main study aims to verify results of the pilot study and test our hypothesis via eye tracking analysis and 
questionnaire.  

Objective 

Our main study hypothesis is that features found to be significantly important by respondents of the pilot study 
survey will be looked at and reported to be important by main study participants. 
 

 

Implementation 

Pilot Study 

Hypothesis 

Our hypothesis is that ratings will have a significantly higher value to participants when making decisions to 
choose businesses. 

Creation 

1. Create an online survey in Google Forms. This survey includes a combination of semantic differential 
questions, true false questions, and multiple choice questions. 

a. Basic demographics: current college attendance, gender, age 
b. Experience with Yelp: frequency and purposes of usage 
c. Importance of Yelp features: rating, review, photos, Q&A, etc. Importance will be measured using: 

i. Semantic differential questions on a scale of 1 - 5 (1 meaning not important, and 5 
meaning very important. 

Administration 

Post survey to the university Facebook group pages for Cal Poly San Luis Obispo, University of Pennsylvania, 
UC Irvine. Received 133 responses.  



Analysis 

1. Creation of an Excel spreadsheet compiled from survey responses. 
2. Controlled for confounding factors such as non-responses, inconsistent answering, and non-users of 

Yelp. We deleted 3 respondents’ data.  
3. Save participant rankingl data as a .csv file. 
4. Load participants ranking .csv file into JMP 
5. Reorganize respondent data to prepare for one-way ANOVA 

a. Open Data File in JMP > Tables > Stack > Select Columns (Features) > Stack Columns > Name 
output table name > Stacked Data Column = Features > Labels = Feature > Source Label = 
Importance > OK 

6. Conduct a one way ANOVA with one condition group (users of Yelp) to compare condition means of the 
importance of features mentioned in the initial survey.  

a. Steps: Analyze > Fit Y by X  > Select Columns = Features > Response (Y)  = Features > Factor (X) = 
Importance > OK > Red Triangle > Means ANOVA 

b. Examine summary statistics. Are the means equal? (Analysis of Variance) 
i. Ho: Means are all the same.  
ii. H1: Two or more means are different than the others.  

c. Use an alpha level of a = 0.5 to find whether or not there is a significant difference in the 
condition means of features. If the p-value is lower than our alpha level of (.05), then our null 
hypothesis (there are no differences between the condition means of importance between 
features) is rejected, and there is a significant difference between the condition means of the 
importance of features. Otherwise, our null hypothesis is true, and there is no significant 
difference between the means of features.  

7. Check that the model assumptions are reasonably well satisfied 
a. Steps: Red Triangle > Saved > Save Residuals > Analyze > Distribution > Select Column = 

Features Centered By >  Columns (Y) = Features Centered By > OK > Red Triangle > Normal 
Quantile Plot 

b. After generating the Normal Quantile Plot, examine whether or not the graph follows a straight 
line distribution. If it does not, model assumptions are not reasonably well satisfied and the 
ANOVA results are invalid. If they are reasonably well satisfied, the ANOVA is likely valid.  

8. (If Ho is rejected and the normal distribution is followed) Find which features are significantly different. 
Do a Tukey HSD.  

a. Steps: Red Triangle > Compare Means > All Pairs, Tukey HSD 
b. Examine the Connecting Letters report.  

i. Which features are significantly higher in values of importance than other groups?  
c. Examine the Ordered Differences reports.  

i. Examine the difference between pairs of features. Which features had the highest ranking 
of importance? Which feature had the lowest? 

9. Report findings, and whether or not ranking was the highest valued feature or not (did it match with our 
original hypothesis?) We will use these results to compare if what users say is important match with their 
actions in the main study.  

 



 

Main Study 

Hypothesis 

Our hypothesis is that users will select businesses that have higher number of reviews, higher average rating, 
and the availability of a full menu. 

Creation 

1. Recruitment of Yelp users (5 participants minimum) 
2. Choose business’ Yelp pages to compare (see section Test Cases) 

a. Three pairs of competing businesses that differ slightly in 1 of the 3 most important features from 
pilot study (Number of reviews, average rating, and full menu availability) 

b. Businesses should not be able to bias users (e.g. that’s already their favorite taqueria) 
c. Control by location (not near SLO) 
d. For test case, control all features except for experimental feature (e.g. different average rating or 

different amount of reviews) 
3. Creation of experiment environment in ExperimentCenter. 

a. Three stimuli: each pair of business’ Yelp pages will open in separate tabs so the participant may 
compare between them. 

Diagram 

Our diagram consists of a picture of the setup of our study, with arrows indicating interacting parts of the study. 
Participants will be able to look at this diagram and understand how they are expected to use various parts of 
the system to complete the task given to them.  
 

 
 

Test Cases 

1. High Number of Reviews 
a. Option 1. Rock Store Bar-B-Q 

i. Rating: 4.5 
ii. # of Reviews: 120 
iii. Full Menu Availability: Yes 

b. Option 2. Sweet Lew’s BBQ 



i. Rating: 4.5 
ii. # of Reviews: 47 
iii. Full Menu Availability: Yes 

c. Hypothesis: Users will select option 1, as it has a higher number of reviews. 
2. Average Rating 

a. Option 1. Tranky’s Tacos 
i. Rating: 5 
ii. # of Reviews: 209 
iii. Full Menu Availability: Yes 
iv.  

b. Option 2. El Tizoncito  
i. Rating: 4 
ii. # of Reviews: 209 (at the time) 
iii. Full Menu Availability: Yes 

c. Hypothesis: Users will select option 1, as it has a higher rating. 
3. Available Full Menu 

a. Option 1. Eastern Paradise Restaurant 
i. Rating: 4 
ii. # of Reviews: 137 
iii. Full Menu Availability: Yes 

b. Option 2. House of Wong Restaurant 
i. Rating: 4 
ii. # of Reviews: 137 
iii. Full Menu Availability: No 

c. Hypothesis: Users will select option 1, as it has full menu availability. 

Administration 

Eye Tracking Research Script 
 

1. Set up 
a. Configure SMI RED250 and experiment is loaded. 

2. Introduction to researcher and device 
a. Ask for permissions to conduct study 

3. Background information collection 
a. Level of familiarity with the Yelp interface 
b. Frequency of use of Yelp 
c. Primary purposes for use of Yelp 
d. Codename 

4. General explanation of study and expectations.  
a. Eye tracking calibration 
b. Establish premise of choosing a business to eat at 
c. Choice of a business 
d. Other details 

i. Don’t click other than to switch between the tabs of the two business’ pages 
ii. Scroll to see more of the business’ page 
iii. Close the window after a choice is made 

5. Begin experiment. 

https://docs.google.com/document/d/1LDdqnCEFaCz5GY_9hehPTO2Kh-1b_0OlpN229AUSt1E/edit?usp=sharing


 

a. Calibration 
b. First pair of businesses will open in separate tabs 

i. Observe participant decision making process 
ii. After a choice is made, ask them why they chose that business 

c. Repeat 5b. for remaining two pairs of businesses 

Analysis 

 
 

1. Control for any possible confounding factors. 
2. For each decision, compare if participants’ reflections on their thought process matches what the 

eye-tracking data reported they looked at. 
3. For each participant, see if there is a difference in dwell time for chosen vs. not-chosen businesses 
4. Compare eye-tracking data to see if there are overall patterns of dwell time of features. 

 

Conclusions 

We will analyze whether or not our primary hypothesis that users place a significantly higher emphasis on 
ratings when choosing between business. 
 
We will compare results between our pilot study and main study to determine if users really value the features 
they say they value. 
 
We will compare results between each main study participant’s trial and their post-trial reflection of their 
decision making process to see if they match 
 
 

 
 

Validation and evaluation 

Pilot Study Results 

The pilot study (Yelp Usage Survey) was divided up into three sections: Demographics, Yelp Experience, and 
Yelp Features. 



Demographic Results 

● Gender 
○ Female - 81.1% 
○ Male - 17.4% 
○ Non-binary - 0.8% 
○ Prefer not to say - 0.8% 

● Age 
○ 18-24 yrs. old - 46.2% 
○ 25-34 yrs. old - 0.8% 
○ 35-44 yrs. old - 2.3% 
○ 45-54 yrs. old - 32.6% 
○ 55-64 yrs. old - 17.4% 
○ 65 yrs. or older - 0.8% 

● College Students 
○ Yes - 42.4% 
○ No - 57.6% 

 

Yelp Experience Results 

A vast majority of respondents used Yelp at least once a month (over 90.2% of respondents). 43.2% of 
respondents used Yelp on a weekly basis. This indicates that a majority of respondents were familiar with the 
Yelp interface, whether that be Web or Mobile.  

 
Pie chart of responses to “How often do you use Yelp?” 



 

Yelp Features Results 

One-way ANOVA 
 

 

We conducted a One-way ANOVA with one condition group (users of Yelp) to compare the condition means of 
the importance of features from our pilot study. According to our One-way Analysis of Ranking by Features, five 
features (Available Full Menu, Average Rating, High Number of Reviews, Photos, and Price Range all ranked 
above the average mean of response to importance rating (m = 3.55).  
 



Summary Statistics of One-way ANOVA 

 

Based on our low p-value of <.001, we reject our null hypothesis (that the means of feature importance are the 
same). There is a significant difference between the importance of at least two or more features based on 
participant data.  



Normal Quantile Plot

 

To check that model assumptions are reasonable satisfied so we may continue with a Tukey HSD analysis, we 
generated a normal quantile plot to see if the graph follows a straight line distribution. Our graph does follow a 
straight line path, so we'll go ahead and proceed and say that there is a significant difference of the importance 
of features of Yelp based on our low p-value ( < 0.01) reported in our One Way ANOVA. 
 

Tukey HSD 

To find which features were significantly different from one another, we proceeded with a Tukey HSD analysis. 
 



Ordered Differences Report (Tukey HSD) 

 

Our Ordered Differences statistics reported that 15 pairs of features were significantly different from one 
another, reporting p-values of less than our alpha level of .05. 14 of those pairs reported p-values of less than 
.001, indicating that there is very high probability of those the first feature being significantly more important than 
the second feature in the pairing. 12 pairs were not significantly different from one another. The highest 
difference between pairs was between Average Rating and Ask the Community (Q&A), with a difference of 1.55. 
The lowest difference between pairs was between Photos and Price Range, with a difference of 0.065.  

Connected Letters Report (Tukey HSD) 

 
 
Through our Connected Letters Report, we found that Average Rating, Available Full Menu, and High Number of 
Reviews were significantly more important to participants, with Average Rating being the most important feature 
with an average score of 4.22 out of 5. Health score provided, Mutual friend, and Ask the Community (Question 
and Answer)  were the least significant features, with Ask the Community (Question and Answer) being the least 
important feature with an average score of 2.67 out of 5.  

Conclusions 

As average rating was the the most important feature to participants, this matches our original hypothesis. 
We will use the metrics from our pilot study to compare if what participants say is important matches with our 
eye tracking results in the main study. 
 



Main Study Results 

We had three main test sets; one for each of the top three most significant results from the pilot study. Namely, 
Number of Reviews, Average Rating, and Availability of Full Menu. Because of this we established for our main 
study the hypothesis that users will select businesses based on higher number of reviews, higher average 
rating, and the availability of a full menu. 
 
To test this hypothesis we divided the test cases into three main sets meant to test each part of our overarching 
hypothesis. 
 

Participant Results 

Note: Option 1 refers to a true hypothesis. Set 1 is testing that users will choose businesses with a higher number 
of reviews. Set 2 is testing that users will choose businesses with a higher average rating. Set 3 is testing that 
users will choose the full business menu restaurant over one without. See Implementation > Main Study > 
Creation > Test Cases for more details 
 
User 1 - Coolgirl 

● Eye tracking results 
● Post Experiment Responses: Pictures, ratings, hours, reviews 
● User Choices:  

○ Set 1: Option 1 
○ Set 2: Option 1 
○ Set 3: Option 2 

 
User 2 - Alex 

● Eye tracking results 
● Post Experiment Responses: Ratings, number of reviews, pictures, price range, reviews 
● User Choices:  

○ Set 1: Option 1 
○ Set 2: Option 1 
○ Set 3: Couldn’t Decide 

 
User 3 - Bubblegum 

● Eye tracking results 
● Post Experiment Responses: Popularity, pictures, number of reviews, hours, reviews 
● User Choices:  

○ Set 1: Option 1 
○ Set 2: Option 2 
○ Set 3: Option 1 

 
User 4 - Greendragon 

● Eye tracking results 
● Post Experiment Responses: Pictures 
● User Choices:  

○ Set 1: Option 2 



○ Set 2: Option 2 
○ Set 3: Option 2 

 
User 5 - Car 

● Eye tracking results 
● Post Experiment Responses: Pictures, ratings, reviews 
● User Choices:  

○ Set 1: Option 1 
○ Set 2: Option 1 
○ Set 3: Option 2 

 
User 6 - Dank 

● Eye tracking results 
● Post Experiment Responses: Ratings, number of reviews, pictures, reviews, average rating 
● User Choices:  

○ Set 1: Option 1 
○ Set 2: Option 1 
○ Set 3: Option 2 

 
User 7 - Squirrel 

● Eye tracking results 
● Post Experiment Responses: Number of reviews, rating, pictures 
● User Choices:  

○ Set 1: Option 1 
○ Set 2: Option 1 
○ Set 3: Option 2 

 
 
 



Hypothesis Analysis 

 
The above chart shows the frequency either option 1 or option 2 were selected from each test set by 
participants. For each set, option 1 was our predicted “winning” option by our hypothesis.  
 
As it can be seen, predictions were correct overall the following percentages: 

● Set 1: 85.7% users chose our predicted choice 
● Set 2: 71.4% users chose our predicted choice 
● Set 3: 16.7% users chose our predicted choice* 

 
*Note: One of the seven users (codename Alex) refused to make a choice for set 3. Their void choice is omitted 
from this calculation. The above results are calculated using the remaining 6 user feedback results instead. 
 
While users did choose overall the restaurants with higher number of reviews and higher ratings, presence of a 
full menu did not significantly impact their choices.  
 
Because of this, our main study’s hypothesis that users will choose businesses with higher number of reviews, 
higher ratings, and full menu availability is wrong as users did not choose the business with the full menu 
availability feature. 
 
 



Analysis of Pilot Study Responses vs. Main Study Post-Experiment Responses 

 
The above chart shows the frequency that each feature was mentioned by the users overall as being important 
to helping them make choices. There are four notable categories, which are: 

1. Pictures, where pictures were any photographic visual featured in reviews or in the restaurant gallery 
2. Ratings, where ratings were the number of “stars” the restaurant was rated (Range [0,5] with 5 perceived 

as “best”) 
3. Reviews, where reviews were textual testimonials including a personal rating by the reviewer and 

sometimes additionally pictures 
4. Number of reviews, where number of reviews were the total number of reviews that the restaurant had 

received at the time of the test 
 
While the results of the pilot study suggests that only ratings and number of reviews--and, additionally, full menu 
availability--are significant, the main study post-experiment survey indicates that pictures, ratings, reviews, and 
number of reviews are more significant to user decision making.  
 

Eye Tracking Results 

Mostly we noticed that re: eye tracking, users looked at every asset. This made our original intention, to note 
which items were sought visually, unhelpful.  
 
Instead, we decided to focus instead upon net dwell time on each Area of Interest (AOI) and net dwell time on 
each AOI as a percentage of total time spent on each page in order to form more helpful conclusions. 
 
We also looked at each participants heat maps to compare if what they looked at matches with what they said 
they looked at to make a decision on which business to go to: 



Post-Experiment Questionnaire compared with Proportion of Dwell Time 

Notes 
● If dwell time is less than 0.5% of total time on page (~150ms), we consider it insignificant. 

○ Values in gray are less than this threshold, meaning they did not look at the item. 
○ Values in green are more than this threshold; the saturation corresponds to the proportion of time 

spent looking at that feature 
● Features highlighted in yellow are items they looked at and said they would look at. 
● Business highlighted in yellow were the ones they chose. 

 
Coolgirl: Post-experiment: Photos, Reviews, Average Rating, Hours 

coolgirl 1.1 rockstore 1.2 sweet lew 2.1 tranky 2.2 tizo 
3.1 eastern 
paradise 

3.2 house of 
wong 

photo 22.09% 24.50% 24.83% 10.86% 16.77% 17.55% 

review 20.32% 39.00% 19.80% 54.18% 56.00% 58.99% 

average rating 1.34% 0.53% 0.33% 0.00% 0.12% 0.70% 

full menu 1.16% 0.00% 13.56% 4.84% 0.06% 0.21% 

hours 0.72% 0.00% 4.08% 2.63% 0.02% 0.07% 

number reviews 0.04% 0.00% 0.01% 0.00% 0.02% 0.15% 

price 0.10%  1.51% 1.59% 0.02% 0.16% 

white space 54.23% 35.96% 35.88% 25.90% 26.99% 22.16% 

 
Alex: Post-experiment: Ratings, Number of Reviews, Pictures, Price Range and Reviews 

alex 1.1 rockstore 1.2 sweet lew 2.1 tranky 2.2 tizo 
3.1 eastern 
paradise 

3.2 house of 
wong 

photo 19.23% 14.46% 7.89% 11.31% 11.93% 15.53% 

review 20.96% 36.93% 34.33% 24.58% 37.78% 18.96% 

average rating 3.98% 2.98% 1.42% 2.81% 1.66% 0.15% 

full menu 1.63% 2.18% 4.41% 6.70% 7.28% 3.14% 

hours 0.08% 1.99% 2.43% 3.58% 2.21% 3.08% 

number reviews 3.72% 0.33% 1.04% 1.59% 0.04% 0.38% 

price 0.01%  1.51% 4.07% 2.09% 0.07% 

white space 50.39% 41.13% 46.96% 45.37% 37.01% 58.69% 

 
Bubblegum: Post-experiment: Average ratings, Photos, Hours, Number of Reviews, Reviews 

bubblegum 
1.1 rockstore 1.2 sweet lew 2.1 tranky 2.2 tizo 3.1 eastern 

paradise 
3.2 house of 
wong 

photo 34.97% 24.43% 8.58% 17.01% 22.85% 12.09% 



review 18.52% 41.35% 14.20% 17.07% 18.99% 49.05% 

average rating 0.22% 0.07% 0.01% 0.07% 0.01% 0.00% 

full menu 1.87% 0.05% 6.79% 0.99% 5.07% 2.38% 

hours 0.41% 0.04% 5.04% 0.81% 0.95% 1.30% 

number reviews 1.72% 1.50% 0.97% 2.22% 0.98% 0.96% 

price 1.20%  0.73% 0.16% 1.62% 0.98% 

white space 41.10% 32.55% 63.68% 61.67% 49.53% 33.24% 

 
Greendragon: Post-experiment: Pictures 

greendragon 
1.1 rockstore 1.2 sweet lew 2.1 tranky 2.2 tizo 3.1 eastern 

paradise 
3.2 house of 
wong 

photo 32.08% 45.96% 22.76% 34.25% 34.55% 42.96% 

review 17.50% 31.16% 26.65% 11.48% 10.95% 32.86% 

average rating 0.51% 0.18% 3.31% 1.79% 0.00% 0.62% 

full menu 4.00% 0.00% 0.00% 0.05% 0.00% 0.00% 

hours 1.76% 0.00% 0.00% 0.03% 0.00% 0.00% 

number reviews 0.91% 0.12% 1.57% 1.09% 0.09% 1.52% 

price 1.13%  0.00% 0.60% 0.02% 0.00% 

white space 42.11% 22.59% 45.72% 50.70% 54.39% 22.04% 

 
Car: Post-experiment: Photos, Ratings, Reviews 

car 
1.1 rockstore 1.2 sweet lew 2.1 tranky 2.2 tizo 3.1 eastern 

paradise 
3.2 house of 
wong 

photo 38.81% 40.82% 20.67% 13.59% 47.71% 11.05% 

review 21.46% 13.29% 32.40% 47.33% 7.20% 51.41% 

average rating 1.10% 1.42% 1.29% 1.74% 1.28% 1.45% 

full menu 1.15% 0.76% 4.86% 2.23% 3.18% 2.80% 

hours 0.36% 0.87% 3.73% 1.87% 0.46% 1.60% 

number reviews 1.96% 0.33% 2.26% 2.35% 0.01% 0.39% 

price 0.48%  0.92% 1.24% 1.63% 1.57% 

white space 34.68% 42.50% 33.85% 29.66% 38.53% 29.72% 

 
Dank: Post-experiment: Ratings, number of reviews, pictures, reviews, average rating.  

dank 
1.1 rockstore 1.2 sweet lew 2.1 tranky 2.2 tizo 3.1 eastern 

paradise 
3.2 house of 
wong 

photo 8.90% 19.77% 13.62% 0.00% 14.40% 15.63% 



review 13.74% 40.84% 30.39% 0.00% 62.37% 34.34% 

average rating 3.17% 0.91% 3.90% 7.79% 0.94% 8.57% 

full menu 2.12% 0.44% 3.08% 0.00% 0.00% 0.01% 

hours 0.87% 0.49% 1.59% 0.00% 0.00% 0.00% 

number reviews 6.93% 0.99% 2.47% 18.16% 1.08% 2.88% 

price 0.57%  0.00% 0.00% 0.00% 0.01% 

white space 63.69% 36.56% 44.94% 74.05% 21.21% 38.56% 

 
Squirrel:  Post-experiment: number of reviews, ratings, pictures 

squirrel 
1.1 rockstore 1.2 sweet lew 2.1 tranky 2.2 tizo 3.1 eastern 

paradise 
3.2 house of 
wong 

photo 19.41% 15.85% 25.87% 13.92% 27.38% 15.96% 

review 0.00% 0.00% 0.00% 0.00% 0.00% 0.00% 

average rating 3.69% 2.61% 6.09% 10.95% 1.44% 0.90% 

full menu 3.86% 5.83% 2.47% 0.21% 0.37% 0.55% 

hours 1.95% 4.05% 0.76% 0.13% 0.04% 0.22% 

number reviews 0.23% 1.00% 0.94% 1.99% 5.68% 2.37% 

price 1.43%  1.09% 0.08% 0.41% 0.29% 

white space 69.43% 70.66% 62.78% 72.73% 64.68% 79.70% 

 

Comparison with Pilot Study 

In this section, we will compare the pilot study results (that average rating, photos, available full menu, and 
number of reviews) are the most important to users.  
 

● Each participant looked at pictures a significant amount, for all trials except for one (participant dank). All 
participants stated that Photos important when it comes to making decisions about businesses for Yelp. 
This concurs with our pilot study results.  

● 6 out of 7 participants said that average rating was important to them. All participants looked at average 
rating, asides from participant bubblegum who said average rating was important. This matches with 
results from our pilot study, as average rating was considered the most important to pilot survey 
respondents.  

● All participants did not include available full menu in their post-questionnaire response, even though it 
was reported to be significantly important to participants from the pilot study results. Results from 
eye-tracking results are divided, as some participants spent a significant dwell time on full menu and 
others did not.   

● Number of reviews. 4 out of 7 participants said that number of reviews was important to them. Out of 
these four, all four looked at number of reviews a significant amount. This somewhat matches with the 
results from our pilot study.  

 



 

Departing from our pilot study, it seems that photos were the most important feature when it comes to making 
decisions from the Yelp interface from the results of the eye-tracking study, not average rating. Average Rating 
and Number of Reviews were also significantly important to our participants, keeping with results from the pilot 
study.  
 
However, we were not able to confirm that full menu availability was important to users based on the low and 
inconsistent dwell time percentages and our qualitative results from the post-experiment questionnaire (no one 
said full-menu availability was  important to them).  
This breaks the part of our original hypothesis that states that full-menu availability is important to users.  
 
We also found the average of percentages of time spent in experiment on businesses chosen is 17.81%, which is 
2.60% more than business not chosen (15.21%). This indicates that people spend more time on business they 
would choose  

 
 

Conclusions 
Our study aimed to find out where users establish credibility through the Yelp interface - specifically it asked 
which features users when making decisions about whether or not to buy from that business. A side goal was to 
figure out whether or not users actually value what they say they value in terms of decision making. Our initial 
hypothesis was that users would place the most importance in the rating score given to a business when 
making a decision. 
 
From our pilot study results, we able to find that users say they value High Number of Reviews, Average Rating, 
Availability of Full Menu, and Photos more than other Yelp features when making decision about whether or not 
to go to a business, with High Number of Reviews being the most important feature. This differed from our 
original hypothesis in that we had assumed average rating was the most important. As a result, we amended 
our hypothesis for the main study to be that users would choose businesses that had higher number of 
reviews, higher average rating, and availability of full menus over other businesses. 
 
From our main study, we used eye-tracking to validate our results from the pilot study. We discovered that users 
reported looking at pictures (26.9%), ratings (19.2%), reviews (19.2%), and number of reviews (15.4%). Pictures 
were found to be a significant feature in decision-making, which isn’t as highlighted from the results of our pilot 
study. Of the three features of a business profile we shaped our main study around (High Number of Reviews, 
Average Rating, Availability of Full Menu), the set focused on testing the significance of Availability of Full Menu 
showed inconsistent results, with participants being divided in scanning the corresponding AOI during the 
experiment. Although the results from the sets focused on High Number of Reviews and Average Rating 
mostly remained consistent with our hypothesis, there was no set in which the participants chose the same 
option across the board.  
 

Features 

To test our hypotheses, we conducted two studies: a pilot study survey where we gauged importance of 
features through a survey consisting of 133 users of Yelp, and controlled experiments where we tracked eye 
movements of users while working through the Yelp interface.  
 



Performance Aspects 

Using eye-tracking to validate how people establish credibility of online review websites has its hits and misses. 
Certainly, the data from the user’s behavior interacting with the interface helped us to compare whether or not 
certain features have been scanned in accordance to what the pilot study and the main study post-experiment 
survey has reported. However, eye-tracking can not address a correlation between dwell time and importance. 
 

Interesting Technical and Implementation Issues (Limitations) 

Main Study: 
● Time limitations: Because of the short time frame and our unfamiliarity with the SMIRED250, we were 

unsure with what data we can extract from conducting our study, and the amount of data we can extract 
that would have a significant amount of importance in our analysis.  

● Contextual meaning of dwell time: Just because a participant looks at a particular feature for a longer 
amount of time in comparison to another, this doesn’t necessarily indicate a greater importance of the 
particular feature. We need to keep in mind that people process different features in varying amounts of 
time. 

● Low number of participants: From our main study, we weren’t able to conclude if there was an obvious, 
significant difference between the importance of features in the decision-making process. This may be 
due to two reasons: 1) There wasn’t enough main study participants or 2) Even with many participants, 
this particular subject matter of our experiment may be too varied to come up with a concise conclusion.  

 

Future Work 

One of the most difficult parts of our experiment was to analyze eye tracking data for different areas of interest, 
since they had drastically different dwell times due to the complexity of the content being viewed (e.g. a 
numerical rating versus a 200 word review with pictures).  
 
This made it very difficult to compare which was more “important” based off of dwell time without introducing a 
complex weighting system to make up for the fundamental complexity between AOIs. Our team decided that if 
we were to run this experiment again, in order to make dwell time a more useful delimiter, we would need to 
only compare AOI that are of similar complexity. In this case, we would only test on average rating, number of 
reviews, hours, and prices. (All short text-based simple complexity AOI).  
 
In hindsight, eye-tracking may not be the best way to validate where users establish credibility with businesses 
because of the contextual meaning of dwell time on feature. Going forward, it would be ideal to incorporate 
more qualitative methods of assessment during eye-tracking experiments to better measure users actual 
throught process while making decision in the Yelp interface.  


